Particle Effects
Week 1
Week 1
Windows 사용자, 2018-01-05
Week 3
Week 4
Week 5
Week 7
Week 9
Week 10
Week 12
Week 13
Week 14
Week 15
### Introduction to Particle Effects

In this course, students will focus on creating visual effects for animation and texturing, lighting, rendering. Projects will consist of creating effects using Maya Dynamics, nParticles, Fluid Effects, Fields and Effects Assets which will be composited into animation. Special attention will be paid to setting, mood, and composition.

#### Teaching Methods

- Lecture, Practice and Critique.
- Analysis: Lecture, Practice and Critique.

#### Teaching Methods

- Teaching means: Lecture, Practice and Critique.
- Analysis: Lecture, Practice and Critique.

#### Teaching Resources


---

<table>
<thead>
<tr>
<th>教研室</th>
<th>任课教师</th>
<th>課程名稱</th>
</tr>
</thead>
<tbody>
<tr>
<td>研究실 번호</td>
<td>담당자</td>
<td>Choi, donghyuk</td>
</tr>
<tr>
<td>授課</td>
<td>课题</td>
<td>Introduction to Particle Effects</td>
</tr>
<tr>
<td>강의주제</td>
<td></td>
<td>3Hours</td>
</tr>
</tbody>
</table>

### Teaching Objectives and Requirements

In this course, students will focus on creating visual effects for animation and texturing, lighting, rendering. Projects will consist of creating effects using Maya Dynamics, nParticles, Fluid Effects, Fields and Effects Assets which will be composited into animation. Special attention will be paid to setting, mood, and composition.

#### Teaching Focus

- Learning the Maya Particle Basic Terms and Production Process for Particle Dynamic Animation.

#### Teaching Difficulties

Students who do not study the basic Maya course may be required to complete the necessary tools for this course production, but it may be difficult to do so.
Week 1: Introduction to Particle Effects.

1. **Bullet Rigid and Soft Body Dynamics**
The Bullet physics engine lets you create large-scale, highly-realistic dynamic and kinematic simulations. You can use Bullet to create content for rendered animations for film and visualization, as well as for the setup of game engine and real-time simulations.

2. **nDynamics Simulation Framework**
nDynamics is a dynamic simulation framework powered by Maya® Nucleus™ technology. A Maya Nucleus system is composed of a series of Nucleus objects, which consists of nCloth, nParticle, nHair, Soft Bodies, and passive collision objects, as well as dynamic constraints, and a Maya Nucleus solver.

3. **nParticles**
nParticles is a particle generation system that uses Maya® Nucleus™ dynamic simulation framework. Use nParticles to create numerous types of effects such as fire, smoke, liquids, and instanced geometry.

4. **Fluid Effects**
Maya Fluid Effects is a technology for realistically simulating and rendering fluid motion. Fluid Effects lets you create a wide variety of 2D and 3D atmospheric, pyrotechnic, space, and liquid effects. You can use the Fluid Effects solvers to simulate these effects, or you can use fluid animated textures for more unique, distinguishing effects.

5. **Maya Fields**
Fields are forces that you use to animate the motion of dynamic objects such as Fluids, Soft Bodies, nParticles, and nCloth. For example, you can connect a vortex field to emitted nParticles to create swirling motion.

6. **Effects and Effects Assets**
Maya Effects lets you quickly create complex animation effects such as smoke and fire. Each Maya effect offers many options and attributes for tuning the results. Effects Assets provides a number of preset effects that are organized as Maya assets.

7. **Work with connections between dynamics objects**
Use the Dynamic Relationships Editor to connect and disconnect dynamic relationships between Nucleus, Fluids, Maya Fields, emitters, and non-Nucleus collision objects.

8. **Dynamics Windows and Editors**
Use these editors with Nucleus and other dynamic objects. The Collision Events Editor lets you create collision events for nParticles. Use the Dynamic Relationships Editor to connect and disconnect dynamic relationships between dynamic objects, such as particles, nParticles, and fluids, and fields, emitters, and collision objects. The Sprite Wizard simplifies the process for displaying a texture image or image sequences on nParticles.
<table>
<thead>
<tr>
<th>作业布置과제제출</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学后记 수업 후기. (手写손으로쓰기)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
## 中韩新媒体学院（）课程授课教案

<table>
<thead>
<tr>
<th>课程号：</th>
<th>课程授课教案</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>任教室研</th>
<th>任课教师</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Choi, donghyuk</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>授课课题</th>
<th>Bullet Rigid Dynamics</th>
</tr>
</thead>
<tbody>
<tr>
<td>教学目标和要求</td>
<td>Learning how to generate and animate Particles.</td>
</tr>
<tr>
<td>教学重点</td>
<td>How to control total number of particles and control movement of particles with turbulence, gravity, vortex, velocity</td>
</tr>
<tr>
<td>教学难点</td>
<td>Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学方法分析</th>
<th>Lecture, Practice and Critique.</th>
</tr>
</thead>
<tbody>
<tr>
<td>教学手段分析</td>
<td>教学手段教科书等：板书教义 □ 多媒体DVD □ 模型示例 □ 实物教具 □ 标本教义 □ 挂图教具 □ 音像教具 □ 其他教具 □</td>
</tr>
<tr>
<td>授课类型和教学方法</td>
<td>理论课□ 讨论课□ 实验课□ 讲习课□ 其他类型 □</td>
</tr>
<tr>
<td>授课时间长度</td>
<td>3Hours</td>
</tr>
</tbody>
</table>

- 教学过程
- 参考资料
**Week2 : Bullet Rigid Dynamics.**

1. Create Bullet Soft Body Anchors

   - Create two Polygon or NURB objects. (In this example, we used a plane and a cube.)
   - Select the object the soft body is to be anchored to, and select Bullet > Active Rigid Body > to open the *Active Rigid Body Options*. In this example, we set the cube's Body Type to Static Body so it doesn't move when we start the solve. Click Apply and Close.
   - Click the object that is to be the soft body and select Bullet > Soft Body > to open the *Soft Body Options*. In this example, we made the plane the soft body and activated the Self Collision option to a believable fabric look. Click Apply and Close.

2. Create a Bullet Ragdoll

   - Add a skeleton to your scene.
   - Select the root joint of the skeleton.
   - Select Bullet > Create Ragdoll from Skeleton >.
   - Adjust the following parameters:
     - Capsule: Bone Length Ratio
     - Capsule Radius: Length Ratio

Note: In the event that you add extra joints to your ragdoll skeleton and want to incorporate them into the ragdoll solve, use the Bullet > *Add Colliders to Skeleton Options* option in the Bullet menu.

3. Create Collisions with Bullet Rigid bodies

This workflow demonstrates the rigid body simulation and collision detection between any two of the three objects.

   - In a new Maya scene, set the Maya Time Slider duration to 100 frames and ensure it is set to play back at frame 1.
   - Create a polygon cube by selecting Create > Polygon Primitives > Cube >.
   - Set the Width, Height, and Depth to 2, and click Create.
   - Position the cube by setting its Translate values to the following:
教学后记

(手写손으로쓰기)
## Course Outline

### Course Title: Bullet Rigid Dynamics

### Instructor: Choi, Donghyuk

<table>
<thead>
<tr>
<th>Teaching Room</th>
<th>Course Title</th>
<th>Time Length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bullet Rigid Dynamics</td>
<td>3 Hours</td>
</tr>
</tbody>
</table>

### Course Objectives:

- Learning how to generate and animate Soft Body Dynamics.

### Course Focus:

- How to control Soft Body Dynamics with turbulence, gravity, vortex, velocity.

### Course Difficulties:

- Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

### Teaching Methods:

- Lecture, Practice and Critique.

### Teaching Aids:

- Board, Multimedia, Model, Material, Sample, Diagram, Sound, Other

### Course Types:

- Theoretical Lecture
- Discussion
- Experiment
- Practice
- Other

---

Week3 : Soft Body Dynamics.

1. Create a cloth simulation with Bullet Soft Body

This workflow demonstrates a simple cloth simulation using a soft body plane and an anchor constraint.

- In a new Maya scene, set the Maya Time Slider duration to 200 frames and ensure it is set to playback at frame 1.

- Create a polygon plane by selecting Create > Polygon Primitives > Plane > □. Set the Width and Height to 5 and the Width divisions and Height divisions to 20. Click Create.

2. Create a hinge simulation with Bullet Rigid Bodies

In a new Maya scene, set the Time Slider duration to 1000 frames and ensure it is set to playback at frame 1.

- Create two polygon meshes by selecting Create > Polygon Primitives > Plane. When you create each plane, set the Width and Height to 5.

- Translate the meshes so that they meet along the Z axis. One way to do this is to set the Translate X value of one mesh to 2.5 and the Translate X value of the other to -2.5.

- Select one mesh and convert it to a passive rigid body by selecting Bullet > Create Passive Rigid Body. This is considered Rigid Body A.

- Select the other mesh and convert it to a active rigid body by selecting Bullet > Create Active Rigid Body. This is considered Rigid Body B.

3. Shatter a Rigid Body simulation

In a new Maya scene, set the Time Slider duration to 100 frames and ensure it is set to playback at frame 1.

- Create a Polygon Cube to be your wall. Select Create > Polygon Primitives > Cube > □.

  Set:
  
  Width to 0.5
  Height to 5
  Depth to 10

Then click Create.

- In the Attribute Editor or Channel Box, with the cube still selected, set the Transform Attributes > Translate values to:
  
  -10.00
This positions the wall at the back end of the grid.
# 中韩新媒体学院（）课程授课教案

## 课程号:

### 教研室

<table>
<thead>
<tr>
<th>연구실 번호</th>
<th>任课教师 담당자</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Choi, donghyuk</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>授课 课题 课程数</th>
<th>nParticles 1</th>
<th>授课时间长度</th>
</tr>
</thead>
<tbody>
<tr>
<td>授课 日期 课程号</td>
<td></td>
<td>3Hours</td>
</tr>
</tbody>
</table>

## 教学目标和要求

Learning nParticles with making rain, snow effects in Maya.

## 教学重点

Learn how to use real-world effects to learn the various functions of the nParticles and develop ability to apply them.

## 教学难点

Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

## 教学方法分析

Lecture, Practice and Critique.

## 教学手段分析

<table>
<thead>
<tr>
<th>教学手段</th>
<th>教学方法</th>
<th>应用范围</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## 授课类型

<table>
<thead>
<tr>
<th>授课类型</th>
<th>理论课</th>
<th>讨论课</th>
<th>实验课</th>
<th>练习课</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## 参考资料


## 教学过程

교육과정
Week 4: nParticles 1.

1. Emit nParticles

Use emitters to generate moving or stationary particles in your simulations. You can use emitters to create smoke, fire, fireworks, rain, and similar objects.

You can set the emitter options to control the initial position, direction, quantity, and speed of the emitted particles. See Create Emitter Options. Before creating an emitter, select an nParticle type by selecting nParticles > Create Options from the FX menu set. Creating any type of emitter adds three objects to the simulation: an emitter, nParticle object, and a Nucleus solver node. The nParticle object is automatically connected to the emitter.

Note: You cannot add an emitter to an object if the emitter already has some other technique controlling its translate attributes. After you add an emitter to an object, you cannot control the emitter’s translate attributes with another technique such as an expression.

2. Create individual nParticles, nParticle clouds, and nParticle grids

Use the nParticle Tool to create individual nParticles, nParticle grids, and random clusters of nParticles anywhere in the scene and on the surface of objects.

nParticles created using the nParticle Tool are static in the first frame of the simulation, but are animated by Nucleus gravity and by collisions with Nucleus objects. By default, Maya creates a Nucleus node at the same time as the nParticleShade node. You can instead assign the nParticle object to an existing Nucleus solver by selecting it in the ParticleTool window (see Particle Tool Options). Nucleus solvers can also be assign to the nParticle object after it has been created. See Fields/Solvers menu.

3. Create nParticle liquids

Create a Water type nParticle object, and then adjust Liquid Simulation attributes to add properties that make the nParticles look and behave like a flowing liquid. Liquid Simulation nParticles work best for contained liquids and small scale liquid flows.

When adjusting nParticle attributes for your simulation, it is useful to adjust an attribute and then cache the simulation. You can then playback the cache to see the results of your attribute adjustments. For information about how nParticle attributes can affect your liquid simulations, see nParticle Liquid Simulation attributes. For information about nCaching, see Create an nParticle nCache. After you setting up your nParticle liquid simulation, you can convert the nParticle object to a polygon mesh. See Work with nParticles meshes.

Tip: When creating nParticle liquid simulations, ensure that the nParticle object's Self Collide attribute is turned off. Otherwise, your nParticles will not overlap, and therefore will not produce a smooth surface.
教学后记

（手写손으로쓰기）
# 基于nParticles的Maya光效制作

## 教学目标和要求
Learning nParticles with making spark effects in Maya.

## 教学重点
Learn how to use real-world effects to learn the various functions of the nParticles and develop ability to apply them.

## 教学难点
Students may have difficulties making good CG effects without good references.

## 教学方法
Lecture, Practice and Critique.

## 教学手段
教学手段：讲授、探究、问答、实验、演示、练习、其他

## 主要参考资料
Week5 : nParticles 2

1. Edit nParticle emitter attributes using workspace manipulators

You can use manipulators in the workspace to edit several emitter attributes:

- Rate
- Direction (directional point emitters only)
- Spread (directional point, curve, and surface emitters only)
- Speed
- Normal Speed (curve and surface emitters only)
- Tangent Speed (curve and surface emitters only)
- Max Distance and Min Distance

The manipulators offer an interactive alternative to typing entries in the Attribute Editor.

2. Color emitted particles using a texture

You can color emitted particles with a 2D or 3D texture. The texture can be the same as the underlying surface or any other texture you create in the scene. Each of the emitters has its own texture emission attributes, so you can apply a different texture (or color) to each group of particles even though each emitter emits the same nParticle object.

With this technique, you can layer a single emitted nParticle object with various colors to create complex particle effects such as smoke or fire. The particles use the emitted nParticle object’s attributes except for color (and optionally opacity), regardless of which emitter emits them.

For example, suppose you add two surface emitters to a plane and connect a single nParticle object to the emitters. The plane can emit particles colored by a black and white checker texture at the same time as particles colored by a purple to yellow ramp texture. The particles are a single emitted particle object. You can display the emitted particles as any render type, for example, spheres, by setting the appropriate attribute in the Attribute Editor for the emitted nParticle object.

3. Create a Rigid Set from Multiple Objects

When you work with simulations that rely on numerous objects in the solve, for example, a wall made of thousands of bricks, it can significantly affect the performance of the simulation. Additionally, it can be tedious to select each object in the Outliner. In these cases, it is best to create a Rigid Set that comprises all of the Rigid Body objects included in the solve.

Note:
- There is no rigid set support for compound and auto-compound collision shapes.
- Freeze scaling before you create a Bullet Rigid Set. Scale transform values are not correctly transferred to the resulting solved object.
<table>
<thead>
<tr>
<th>作业布置과제제출</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学后记 수업 후기. (手写손으로쓰기)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>课程号:</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>授课 课题</td>
</tr>
<tr>
<td>授课时间长度</td>
</tr>
<tr>
<td>教学目标和要求</td>
</tr>
<tr>
<td>教学重点</td>
</tr>
<tr>
<td>教学难点</td>
</tr>
<tr>
<td>教学方法分析</td>
</tr>
<tr>
<td>教学手段分析</td>
</tr>
<tr>
<td>授课类型</td>
</tr>
</tbody>
</table>
Maya Fluid Effects is a technology for realistically simulating and rendering fluid motion. Fluid Effects lets you create a wide variety of 2D and 3D atmospheric, pyrotechnic, space, and liquid effects. You can use the Fluid Effects solvers to simulate these effects, or you can use fluid animated textures for more unique, distinguishing effects.

Fluid Effects also includes an ocean shader for creating realistic open water. You can float objects on the ocean surface and have those objects react to the motion of the water.

1. Import Fluid examples

Maya provides example files of complete fluid, ocean, and pond effects. Each example file includes the fluids, geometry, shaders, lights, cache files, and environments required for the effect. You can quickly import them into your scene, play, and render them without alteration.

Modify these files to customize the effects, use them as learning tools to understand how to create your own effects, or use them simply for ideas.

2. Create dynamic fluid effects

When you play the simulation, Maya applies the fluid dynamics solver to the values in the container, calculating new values at each time step and replacing old values in the grid with the new ones.

Explosions, flames, smoke, and lava are examples of effects you could create as dynamic fluid effects. You can also create fluid effects that look and behave like liquids such as water. See Liquid simulation setup.

For examples of basic dynamic fluid effects, see Fluid Effects Lessons One and Three in Getting Started with Maya. You can also load the examples in the Fluid Examples folder in the Content Browser - see Import Fluid examples.

3. Create non-dynamic fluid effects

In non-dynamic fluid effects the fluid property values are predefined within Maya and stay constant over time, which means they don’t have to be recalculated. You create the appearance of the fluid by texturing a special fluid shader that is built-in to the fluid. This shader is built into the fluid for better performance. If you want the fluid effect to have motion, you can animate (keyframe) the texture attributes. Because Maya doesn’t solve the fluid dynamics equations, rendering this type of fluid is much quicker than rendering a dynamic fluid.

Clouds, fog, space, and other more abstract effects are good candidates for non-dynamic effects.

For an example of a basic non-dynamic fluid effect, see Fluid Effects Lesson Two in Getting Started with Maya. You can also load the examples in the Fluid Examples folder in the Content Browser - see Import Fluid examples.
<table>
<thead>
<tr>
<th>作业布置과제제출</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学后记 수업 후기 (手写손으로쓰기)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
### Course: Fluid Effects 2

**Instructor:** Choi, Donghyuk

**Course Topic:** Introduction to Maya Fluids and making realistic flames using Fluids

**Teaching Goals:**
Students learn how to use Maya Fluids and to make accurate, realistic CG effects in Maya.

**Teaching Difficulties:**
Maya Fluids effects demand very high hardware specs to calculate and make accurate result. Students may need good workstations for this class.

**Teaching Methods:**
Lecture, Practice and Critique.

**Teaching Aids:**
1. Create a fluid containers with emitters

You can create a fluid container and then add an emitter. The emitter is automatically parented to the container so they move together when you move the container.

2. Color fluids using shading color

The fluid container has a built-in shader that you can use to modify the color, texture, and other attributes of the container to give the fluid a particular look.

3. Emit fluids from objects

As with other fluid properties, adding color to a grid gives you control over the precise color values placed in each voxel.

The default grid color is green/brown (close to RGB 0.4 0.4 0.3) to minimize fringing when you add color. If this is not an acceptable grid color, flood the color grid with the color you want and set it as your initial state, see Flood a container with values and Fluids initial state.

When you add color to a dynamic grid, the color values are solved using the fluid dynamics equations.

4. Related topics

- Fill geometry with fluid
- Emit fluids using emission maps
- Emit fluid properties into grids
- Emit fluid properties with nParticles
<table>
<thead>
<tr>
<th>教研室 번호</th>
<th>任课教师 담당자</th>
<th>Chois, donghyuk</th>
</tr>
</thead>
<tbody>
<tr>
<td>授课 课题  강의주제</td>
<td>Midterm Project</td>
<td>授  课  时间长度  강의 시간</td>
</tr>
<tr>
<td>教学  目标和要求  강의목표</td>
<td>Understanding CG VFX Production Process through Midterm Project</td>
<td></td>
</tr>
<tr>
<td>教学  重点  강의중점</td>
<td>Students will practice all the knowledge and skills they learned in this class to make their VFX shots</td>
<td></td>
</tr>
<tr>
<td>教学  难点  강의난점</td>
<td>Students may need good workstations for this class.</td>
<td></td>
</tr>
</tbody>
</table>

| 教学方法分析  강의방법분석 | |
| 教学手段分析  교학수단분석 | |
| 授课类型  강의유형 | |
Week8: Midterm Project

Students submit their Midterm Project material (Video, PPT, Sample works) to E-class.
# Maya Fields 1

## Learning how to generate and animate Maya Fields

### How to control total number of particles and control movement of particles with turbulence, gravity, vortex, velocity

### Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

### Lecture, Practice and Critique.

1. Introduction Maya Field

Fields are forces that you use to animate the motion of dynamic objects such as Fluids, Soft Bodies, nParticles, and nCloth. For example, you can connect a vortex field to emitted nParticles to create swirling motion.

A soft body can be creates from a polygonal surface, NURBS surface, NURBS curve, lattice, wire, or wrap deformer. A rigid body can be created from a polygonal or NURBS surface. For information about Soft bodies, rigid bodies and how to combine the influence of fields with the keyed translation of these objects, see Maya Classic Dynamics.

2. Stand-alone fields

Stand-alone fields influence objects from a stationary or moving position in the workspace. A stand-alone field is not owned by geometry. It is represented by an icon in the workspace and by an independent node in the Outliner.

3. Object fields

Object fields are owned by an object and exert influence from the object. An object field is represented by an icon on or near the object in the workspace, and by an entry under the owning object in the Outliner. An object can own multiple fields.

You can add fields to polygons, NURBS curves or surfaces, particle objects, lattices, or curves on surfaces. You can make the field have influence from some or all CVs, edit points, vertices, or lattice points. Alternatively, you can make the influence occur from the average position of the points.

You can add a field to all particles of a particle object, not just to some of the particles. For a curve on surface, you can add fields to the entire curve or to specific edit points, not to specific CVs. If you use edit points, add a field only to the end edit points for best results.
<table>
<thead>
<tr>
<th>教学后记</th>
<th>수업 후기. (手写손으로쓰기)</th>
</tr>
</thead>
</table>

# Maya Fields 2

## 강의주제
- Learning how to generate and animate Maya Fields

## 강의중점
- How to control total number of particles and control movement of particles with turbulence, gravity, vortex, velocity

## 강의난점
- Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

## 강의방법분석
- Lecture, Practice and Critique.

## 강의자료분석

---

**教学过程**

1. Connecting and disconnecting Maya fields

This example describes how to use the Dynamic Relationships Editor to connect a Vortex field, which is already connected to a Maya classic particle object, to a soft body and an nParticle object. The Vortex field is then disconnected from the classic particle object.

To connect and disconnect Maya fields

- Open the Dynamic Relationships Editor by selecting Windows > Relationship Editors > Dynamic Relationships.
- In the left panel of the Dynamic Relationships Editor, select the objects whose connections you want change.

In this example, you select the particle, soft body, and nParticle objects in the left panel. Use Ctrl -click to select multiple objects.

- Set the Selection modes to Fields.

The fields that are currently connected to the particle object are displayed highlighted in the right panel under \textit{particle1}. Also, the fields that can be connected to the soft body and nParticle objects are listed under \textit{pPlane1Particle} and \textit{nParticle1}. By default, when you select soft body objects in the left panel, the object displays in the right panel with its associated particle object appended to its object name.

2. Connect and disconnect collision geometry

This example describes how use the Dynamic Relationships Editor to connect collision object (\textit{pCubeShape1}) to a particle object so that they collide. The object is currently connected to collide with a second particle object.

Note: Nucleus-based collisions, such as collisions between nCloth, nParticle, or passive collision objects, cannot be edited using the Dynamic Relationships Editor.

To connect and disconnect collision geometry

- Open the Dynamic Relationships Editor by selecting Windows > Relationship Editors > Dynamic Relationships.
- In the left panel of the Dynamic Relationships Editor, select the objects that you want to connect to or disconnect from collision geometry.
- Set the Selection modes to Collisions.

The geometry (\textit{pCubeShape1}) that is currently connected to collide with the particle1 object displays highlighted in the editor’s right panel under \textit{particle1}, and the geometry (\textit{pCubeShape1}) that can be connected to collide with particle2 object displays under \textit{particle2}
3. Connect and disconnect emitters

You can connect a particle object to an emitter that is currently connected to another object.

For example, you can create a curve with two directional point emitters, emitter1 and emitter2. Emitter1 emits particle spheres to the right, while emitter2 emits particle streaks to the left. In the following figure, the spherical particles are particle1 and the streaking particles are particle2.

4. Related topics

- Connecting and disconnecting Maya fields
- Connect and disconnect collision geometry
- Dynamic Relationships Editor
<table>
<thead>
<tr>
<th>教研室</th>
<th>任课教师</th>
</tr>
</thead>
<tbody>
<tr>
<td>任课教师</td>
<td>Choi, donghyuk</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>授课课题</th>
<th>Maya Effects 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>授课时间长度</td>
<td>3Hours</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学目标和要求</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning how to generate and animate Maya Effects</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学重点</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to control total number of particles and control movement of Maya Effects</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学难点</th>
</tr>
</thead>
<tbody>
<tr>
<td>Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学方法分析</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lecture, Practice and Critique.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学手段分析</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teaching methods: Lecture, Practice and Critique.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>教学资料参考资料</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>教学过程教育過程</th>
</tr>
</thead>
</table>
Week11 : Maya Effects 1

1. Create a Fire effect

Fire effect to emit fire from these objects:

- nParticle object
- NURBS or polygonal surface
- NURBS curve
- Number of CVs, vertices, edit points of an object
- Lattice points

2. Create fireworks

- Prepare to use the Fire effect

Before you use the Fire effect, be aware of these issues:

Use the Fire effect on only one object at a time.

To apply Fire to a group of NURBS surfaces, first convert each surface to polygons and combine the surfaces. From the Surfaces menu set, select Modify > Convert > NURBS to Polygons, then from the Polygons menu set choose Mesh > Combine.

To apply Fire to a group of polygonal surfaces, simply combine the surfaces with Mesh > Combine.

If you emit from a NURBS or polygonal object, the size and shape of the object affects the quality of the fire. You’ll need to use an object large enough to generate an adequate flame area. If you emit fire from a curve, avoid using a curve with abrupt changes in direction.

It’s often useful to use the Fire effect on the same geometry more than once. By setting options differently with each usage, you can create a complex look not possible with a single usage.

If you want to animate the movement of the fire around the workspace, consider using the Fire effect on a particle object. You can work with per particle expressions on particle objects, so you have more flexibility in altering the fire’s motion.

You’ll often need to emit flames from part of an object rather than from its entire geometry. In some instances, the part of the object where you want the fire won’t have geometry present. A common technique in such cases is to emit from an invisible geometric object in that area.

3. Flow effects

The Curve Flow effect emits particles that flow along a curve you create. You can use this effect to create flowing fluids, gases, or instanced objects. The emitted particles start at the first CV and end at the last CV you drew when you created the curve.

For example, to make water flow down a ravine, you would first create a NURBS or polygonal surface as the hill with a ravine. You then create a curve in the middle of the ravine from beginning to end. You use the Curve Flow effect on the curve and adjust the Curve Flow attributes. Finally, you select an
appropriate render type such as Blobby Surface for the emitted particles and adjust their appearance. Usage, you can create a complex look not possible with a single usage.
Tip: You can use the Curve Flow effect on a curve or surface as a convenient way to guide the flow along deformed surfaces. It’s often helpful to duplicate the curve or surface, raise the copy above the surface, then apply the Curve Flow effect to the copy.
To keep particles flowing within a planar boundary, for instance, water flowing down a river, you can sandwich the curve between invisible planes and then make the particles collide with the planes. The particles bounce within the two invisible planes.
## 中韩新媒体学院( )课程授课教案

### 课程号： 资源编号：
### 任课教师： Choi, donghyuk

<table>
<thead>
<tr>
<th>授课 课题</th>
<th>Maya Effects 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>教学目标和要求</td>
<td>Learning how to generate and animate Maya Effects</td>
</tr>
<tr>
<td>教学重点</td>
<td>How to control total number of particles and control movement of Maya Effects</td>
</tr>
<tr>
<td>教学难点</td>
<td>Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.</td>
</tr>
<tr>
<td>教学方法分析</td>
<td>Lecture, Practice and Critique.</td>
</tr>
<tr>
<td>教学手段分析</td>
<td>Teaching methods: Teaching, Practice, and Criticism.</td>
</tr>
<tr>
<td>授课类型</td>
<td>Theory, Discussion, Experiment, Practice.</td>
</tr>
</tbody>
</table>

### 教学过程

- 教学方法：
  - 讲授
  - 探究
  - 问答
  - 实验
  - 演示
  - 练习
  - 其他

- 教学手段：
  - 板书
  - 多媒体
  - 模型
  - 实物
  - 标本
  - 挂图
  - 音像
  - 其他

- 授课类型：
  - 理论
  - 讨论
  - 实验
  - 练习

- 参考教材：
Week12 : Maya Effects 2

1. Create curve flow

- To use the Curve Flow effect
- Edit attributes of the Curve Flow effect
- Work with flow locators

Flow locators control the speed and diameter of the flow in different parts of the curve. You can scale the flow locator rings to expand or shrink the flow diameter in that area. You can move the rings along the curve to speed or slow the flow in that area. This is useful when you’re simulating fluid flow down uneven surfaces. The flow is slower where rings are closer together. The flow is faster where rings are further apart. You can therefore space the rings to adjust the flow speed.

2. Create a surface flow

The surface flow effect emits particles that flow along the surface of any NURBS model. You can use this effect to create flowing fluids, gases, or instanced objects. The flow effect automatically adjusts to any changes in the shape of the surface

- Set surface flow creation controls

The creation controls apply only at the time of creation. You cannot modify these controls later.

- Editing a surface flow

You can edit these attributes after you create the Surface Flow effect by selecting the surface flow selection handle and opening the Channel Box or the Attribute Editor, Extra Attributes section

3. Surface Flow procedures

There are several global procedures provided with the Surface Flow effect that allow you to query information about the surface flows in your scene.

The surface flow effect is achieved through the manipulation of ramp textures and goal objects. This procedure returns the names of all of the ramp textures used by the surface flow you specify.

The number of ramps created depends on the values of the three resolution options used to create the effect. The ramps are used as a part of the construction history for the animation of the effect not as a part of a rendering network. The ramps don’t appear in the Texture sections in the Visor or HyperShade because they can easily outnumber the rendering textures in the scene. The ramps do appear in the networks drawn in the main windows of the HyperGraph and HyperShade because they are useful parts of those networks.
# Course Lesson Plan

## Course Information

<table>
<thead>
<tr>
<th>Course Code:</th>
<th></th>
<th>Choi, donghyuk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Research Room Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Teaching Course Title</td>
<td>Maya Effects 3</td>
<td></td>
</tr>
<tr>
<td>Teaching Duration</td>
<td>3 Hours</td>
<td></td>
</tr>
</tbody>
</table>

## Teaching Goal and Requirement

Learning how to generate and animate Maya Effects

## Teaching Focus

How to control total number of particles and control movement of Maya Effects

## Teaching Difficulties

Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

## Teaching Method Analysis

Lecture, Practice and Critique.

## Teaching Method

- Teaching Method Analysis: Lecture, Practice and Critique.
1. Create lightning

The Lightning clip effect creates a bolt of lightning between two or more objects or locators. The lightning bolt is made up of soft body curves with extruded surfaces, which are rendered. The motion of the lightning is derived from an expression on the particles that make up the soft body curve.

When you create lightning, you set the Lightning Creation Controls in the Create Lightning Effect Options window to determine certain aspects of the lightning. You cannot change these once the lightning is created. If you want to change them, you must delete the lightning and recreate it.

You can also set the Lightning Attributes in the options window. These attributes can be edited after you create the lightning.

2. Create shatter

Shatter duplicates an object and breaks the duplicate into multiple pieces called shards. Depending on the type of shard you choose to create, you can move the shards with dynamic forces or keyframe their movement.

Shatter provides three methods of breaking the object:

- Surface Shatter
- Solid Shatter
- Crack Shatter

3. Connect shards to fields

Once you’ve shattered your object, you can move the shards with the move tool and keyframe the motion, or you can connect the shards to a Maya field and let the field move the shards.

Note: If you add a field to shards that are shapes, the software automatically converts the shapes to active rigid bodies with collision on. This will cause interpenetration problems with the rigid bodies because the shard’s edges overlap each other. Turning off collisions for the rigid bodies solves this problem.

- To connect rigid body shards to fields

  In the Outliner, expand the shatter node.
  Highlight the shards you want affected by the field.
  From the FX menu, select Fields/Solvers > *fieldname*.

  The field is created and connected to the shards.

- To connect soft body shards to fields

  In the Outliner, expand the shatter node.
  Expand the shard you want affected by the field and select the shard particle shape.
(shard#Particle).

If you want all the shards to be affected by the field, you must select the particle shape for each shard.

From the FX menu, select Fields/Solvers > *fieldname*.
The field is created and connected to the shards.

4. Create Smoke

The Smoke effect emits smoke from a position in the workspace or from a selected particle object or geometry object. The effect uses a series of smoke images (sprites) included with the Maya software. You can alternatively use your own images. You must hardware render the resulting smoke.
# Maya Effects Assets

## Teaching Objectives and Requirements
Learning how to generate and animate Maya Effects Assets

## Teaching Key Points
How to control total number of particles and control movement of Maya Effects

## Teaching Difficulties
Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

## Teaching Methods
- Lecture, Practice and Critique.

## Teaching Means of Instruction
- Classwork: Lecture, Practice and Critique
- Teaching approach: Teaching, Inquiry, Questioning, Experiment, Demonstration, Practice, Others

## Teaching Process

<table>
<thead>
<tr>
<th>授课类型</th>
<th>理论课イ론수업</th>
<th>讨论課토론수업</th>
<th>实验課실습수업</th>
<th>练習課연습수업</th>
<th>其他기타</th>
</tr>
</thead>
</table>
Week14 : Maya Effects Assets

1. Maya Effects Assets

Effects Assets provides a number of preset effects that are organized as Maya assets. Effects Assets are available in the Content Browser and can be quickly imported into your scene, applied to objects, then played and rendered with little or no modification. Effects Assets include 3D fluid effects, nParticles, nParticle emitters, and Maya fields, and provide effects such as explosions, fire, smoke, rain, and fireworks.

Effects Assets are advanced assets, which allow them to be parenting objects outside the asset. For example, some assets, such as a fire asset, can be parenting to a polygon object or applied as a surface emitter. Depending on the effect, selecting Effects Assets > Apply Effect from the FX menu set either parents the effect to an object, or applies it to a surface. Effects with Point or Volume emitters are parenting while Surface emitter are applied. Free-standing effects, such as the Bomb.ma, do not need to be applied to objects in the scene.

Effects Assets do not use asset templates or binding sets. For information about Maya assets, see Assets.

2. Modify an effects asset

The easiest way to modify an effect is to adjust the asset's published attributes. These attributes provide control to the specific characteristics of the effect. For example, the Fire asset has attributes that adjust flame density, speed, and height as well as the amount of emitted sparks.

Note: You can access the attributes of the asset's internal nodes by expanding the asset in the Outliner, then selecting the individual nodes. Be aware that adjusting the internal node attributes may affect the way the Published Attributes control your effect.

3. Topics in this section

Effects Assets and collision objects
Published nodes
Importing and modifying Effects Assets
<p>| 教学后记 | 수업 후기 | (手写손으로쓰기) |</p>
<table>
<thead>
<tr>
<th>教研室</th>
<th>任课教师</th>
<th>Choi, donghyuk</th>
</tr>
</thead>
<tbody>
<tr>
<td>授课</td>
<td>课题</td>
<td>Making waves with BOSS</td>
</tr>
<tr>
<td>任课教师</td>
<td>任课教师</td>
<td>韩语</td>
</tr>
<tr>
<td>授课</td>
<td>时间长度</td>
<td>3Hours</td>
</tr>
<tr>
<td>课题</td>
<td>教学目标和要求</td>
<td>Learning how to generate and edit BOSS</td>
</tr>
<tr>
<td>教学</td>
<td>重点</td>
<td>How to Create and Control Waves with BOSS</td>
</tr>
<tr>
<td>目标和要求</td>
<td>教学重点</td>
<td></td>
</tr>
<tr>
<td>学生</td>
<td>学生</td>
<td>Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.</td>
</tr>
<tr>
<td>学生</td>
<td>教学方法</td>
<td>Lecture, Practice and Critique.</td>
</tr>
<tr>
<td>学生</td>
<td>教学方法分析</td>
<td></td>
</tr>
<tr>
<td>教学手段</td>
<td>教学手段分析</td>
<td></td>
</tr>
<tr>
<td>各种教科书</td>
<td>各种教科书</td>
<td></td>
</tr>
<tr>
<td>授课类型</td>
<td>授课类型</td>
<td></td>
</tr>
<tr>
<td>教学手段</td>
<td>教学手段</td>
<td></td>
</tr>
</tbody>
</table>

教学过程

교육과정
Week15 : Making waves with BOSS

1. Get started making waves with BOSS

Here is a quick example to give an overview of the steps for creating an ocean surface using the Bifröst Ocean Simulation System.

2. Add and edit BOSS solvers

The Bifröst Ocean Simulation System uses solvers to generate waves and displace geometry. You can use multiple solvers on the same geometry, and blend their effects together.

To display a solver's attributes in the Attribute Editor, make sure that Auto Select Nodes is on in the Boss Ripple / Wave Generator window and then select a solver in the Wave Solver list on the left.

For a brief description of an attribute, hover the pointer over it. If a tooltip does not appear after a brief delay, make sure that Display Toolclips is on in your Help preferences.

Here are some notes on a few of the settings:

   When blending the result of multiple solvers on the same domain, use Wave Height to control the strength of each solver, including its influences.

   Resolution X and Resolution Z control the resolution of the simulation, as opposed to the mesh. They are also used for the size of the cache EXR files. For best results, these attributes should match the aspect ratio of the domain in the scene's world X and Z axes. Different solvers can have different resolutions on the same domain, if you don't need the same level of detail from each solver. You can change resolution at any time — for example, start with a low resolution for faster playback, and then increase it for more detail.

   Gravity m/s² is the main controller for scale. The default value of 9.8 assumes that a grid unit is 1 meter when Maya's Linear working unit is set to the default value of cm. You should adjust this value if your scene is modeled to a different scale.

   If you will be using the EXR cache files for vector displacement, or if you will be using the mesh to guide a Bifröst liquid simulation, then turn on Use Horizontal Displacement and optionally adjust Wave Size to capture the horizontal motion as well.

   For spectral wave solvers, Patch Size X (m) and Patch Size Z (m) control the size of ocean surface to simulate, assuming again that a grid unit is 1 meter when Maya's Linear working unit is set to the default value of cm.

3. Add and edit BOSS influences

Influences are the objects used to generate and reflect waves in the Bifröst Ocean Simulation System. They can be used to create effects like ripples, bow waves, and Kelvin wakes.

In addition to static and animated meshes, you can use an EXR file. For example, you can use a single EXR image instead of geometry for a complex shoreline with rocks. For another example, you can use a sequence of EXR images to create a pattern of rain falling on a surface of water.
Each influence can act as a generator that creates waves, as a collider that reflects waves, or as both. When an influence is both a generator and a collider, the region that acts as a collider should be a bit smaller than the region that acts as a generator so that waves can form properly in the band between them — you can adjust the Generator Expand and Collider Shrink attributes to adjust the width of this band.

Tip: Use hidden meshes as extra influences for more control over different parts of the effect. For example, you can use a simple mesh at the back of a boat to increase the wake.

4. Cache BOSS solvers and influences

You can cache the effect of BOSS solvers. This can improve playback by avoiding the recalculation of complex simulations every frame. Caches are stored as EXR files on disk, in subfolders of the cache/Boss/ folder in your project directory by default.

You can also cache geometry influences. For example, if the animation of a boat has been finalized, you can cache it to avoid resampling something that will not change. Once a generator influence has been cached, you can still adjust its Amplitude.
# Final Project

### Teaching Goals and Requirements

*Understanding CG VFX Production Process through Final Project*

### Teaching Focus

Students will practice all the knowledge and skills they learned in this class to make their VFX shots.

### Teaching Challenges

Students may need good workstations for this class.

### Teaching Methods

- Lecture
- Discussion
- Experiment
- Demonstration
- Practice
- Other

### Teaching Aids

- Board
- Textbook
- Multimedia
- Model
-实物
- Specimen
- Poster
- Film
- Other

### Teaching Type

- Theory Course
- Discussion Course
- Experiment Course
- Practice Course
- Other

### Reference Material

Week16: Final Project

Students submit their Final Project material (Video, PPT, Sample works) to E-class.
## 《파티클이펙트(Particle Effect)》강의지도계획  教学指导计划

### 一、기본정보 基本内容

<table>
<thead>
<tr>
<th>과목명칭 课程名称</th>
<th>파티클이펙트</th>
<th>학과종류 课程类型</th>
</tr>
</thead>
<tbody>
<tr>
<td>영문명칭 英文名称</td>
<td>Particle Effects</td>
<td></td>
</tr>
<tr>
<td>총시수 总课时</td>
<td>45</td>
<td>이론시수 理论课时</td>
</tr>
<tr>
<td>이론시수 理论课时</td>
<td>45</td>
<td>실험시수 实验课时</td>
</tr>
<tr>
<td>실험시수 实验课时</td>
<td></td>
<td>실습시수 实习课时</td>
</tr>
<tr>
<td>학점 学分</td>
<td>3</td>
<td>예정시수 预定课时</td>
</tr>
<tr>
<td>적용 대상 适用对象</td>
<td>한중뉴미디아학원 韩中新媒体学院</td>
<td>과목담당자 负责人</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>과목설명 课程说明</th>
</tr>
</thead>
<tbody>
<tr>
<td>In this course, students will focus on creating visual effects for animation and texturing, lighting, rendering. Projects will consist of creating effects using Maya Dynamics, nParticles, Fluid Effects, Fields and Effects Assets which will be composited into animation. Special attention will be paid to setting, mood, and composition.</td>
</tr>
</tbody>
</table>

### 二、교육 목표 및 임무 教学目标及任务

Student will be able to

- Create their own particle effects using Maya Dynamics, nParticles, Fluid Effects, Fields and Effects Assets
- Create rigid body and soft body simulations
- Control particles and their attributes beyond dynamic simulation tools using MEL and expressions
- Make educated decisions and trouble shoot dynamic simulations
- Create complex effects by combining all of the above

三 教时安排 课时安排

<table>
<thead>
<tr>
<th>주간</th>
<th>수업내용</th>
<th>수업형식 및 시간안배</th>
<th>시간합계</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>课程形式及时间安排</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>이론</td>
<td>실험</td>
</tr>
<tr>
<td>1</td>
<td>Introduction to 3D Particle Effects</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>2-3</td>
<td>Bullet Rigid and Soft Dynamics</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>4-5</td>
<td>nParticles</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>6-7</td>
<td>Fluid Effects</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Midterm</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>9-10</td>
<td>Maya Fields</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>11-13</td>
<td>Maya Effects</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Effects Assets</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>BOSS</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Final Exam</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

四、수업내용 및 수업요구 课程内容及课程要求

제 1 장 Introduction to Particle Effects

제 1 절. Basic Concept of Maya Particles
본장 교학목적 : Learning Basic Maya Particles

본장의 주요 내용 : Learning the Maya Particle Basic Terms and Production Process for Particle Dynamic Animation.

본장 난점 : Students who do not study the basic Maya course may be required to complete the necessary tools for this course production, but it may be difficult to do so.

본장 중점 : Understanding basic concept of Maya Particles


본장 사고문제 : Dynamic Animation, Emitter, Particles, nParticle, Fields, Physics

제 2 장 Bullet Rigid Dynamics

1 절 Create Bullet Rigid Dynamics
2 절 Create Collisions with Bullet Rigid bodies

본장 교학 목적 : Learning how to generate and animate Particles.

본장의 주요 내용 : Creating Emitters and Particles and animate Particles using Rigid Body Dynamics.

본장 난점 : Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

본장 중점 : How to control total number of particles and control movement of particles with turbulence, gravity, vortex, velocity


본장 사고문제 : Controlling Velocity of Particles, Emit with Fields to make natural movement

제 3 장 Soft Body Dynamics

1 절 Create Soft Body Dynamics
2 절 Create Cloth Simulation with Bullet Soft Body

본장 교학 목적 : Learning how to generate and animate Soft Body Dynamics.

본장의 주요 내용 : Creating Emitters and Particles and animate Particles using Soft Body Dynamics
본장 난점: Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

본장 중점: How to control Soft Body Dynamics with turbulence, gravity, vortex, velocity.


본장 사고문제: Controlling Velocity of Particles, Emit with Fields to make natural movement

제 4 장 nParticles 1

1 절 Create a cloth simulation with nParticles

본장 교학 목적: Learning nParticles with making rain, snow effects in Maya

본장의 주요 내용: Using reference clips of natural Phenomenon for making rain, snow, effects in Maya. Students will learn advanced attributes and options with this practice

본장난점: Students may have difficulties making good CG effects without good references

본장중점: Learn how to use real-world effects to learn the various functions of the nParticles and develop ability to apply them.


본장 사고문제: Think about how to make wave effects

제 5 장 nParticles 2

1 절 Create a cloth simulation with nParticles

본장 교학 목적: Learning nParticles with making spark effects in Maya

본장의 주요 내용: Using reference clips of natural Phenomenon for making spark effects in Maya. Students will learn advanced attributes and options with this practice

본장난점: Students may have difficulties making good CG effects without good references

본장중점: Learn how to use real-world effects to learn the various functions of the nParticles and develop ability to apply them.

본장 참고문헌: 주교재: Main teaching material: Maya Visual Effects The Innovator’s
제 6 장 Fluid Effects 1

1 절 Understanding the Concepts of Fluid Dynamics.
2 절 Create dynamic fluid effects
3 절 Create non-dynamic fluid effects

본장 교학 목적: Introduction to Maya Fluids and making realistic flames using Fluids.
본장의 주요 내용: With Maya Fluids, Students are able to make realistic natural phenomenon like fire, flame
본장난점: Maya Fluids effects demands very high hardware specs to calculate and make accurate result. Students may need good workstations for this class.
본장중점: Students learn how to use Maya Fluids and to make accurate, realistic CG effects in Maya.

본장 사고문제: What is difference between effects creating nParticles and Maya Fluids.

제 7 장 Fluid Effects 2

1 절 Color Fluids using shading Color
2 절 Making Realistic Flames(candle, bonfire, gas)

본장 교학 목적: Introduction to Maya Fluids and making realistic flames using Fluids.
본장의 주요 내용: With Maya Fluids, Students are able to make realistic natural phenomenon like fire, flame
본장난점: Maya Fluids effects demands very high hardware specs to calculate and make accurate result. Students may need good workstations for this class.
본장중점: Students learn how to use Maya Fluids and to make accurate, realistic CG effects in Maya.

본장 사고문제: What is difference between effects creating nParticles and Maya Fluids.
What are the Pros and Cons of Maya Fluids.

제 8 장 Midterm
1 절 Midterm Project
본장 교학 목적: Understanding CG VFX Production Process through Midterm Project
본장의 주요 내용: Planning to make a VFX shot
본장난점: none.
본장중점: Students will practice all the knowledge and skills they learned in this class to make their VFX shots.
본장 사고문제: To make large scale explosion effects.

제 9 장 Maya Field 1
1 절 Introduction about Maya Fields
2 절 Create Fields
본장 교학 목적: Learning how to generate and animate Maya Fields.
본장의 주요 내용: Creating Fields such as wind, gravity, turbulence, etc.
본장 난점: Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.
본장 중점: How to control total number of particles and control movement of particles with turbulence, gravity, vortex, velocity
본장 사고문제: Controlling Velocity of Particles, Emit with Fields to make natural movement

제 10 장 Maya Field 2
1 절 Introduction about Maya Fields
2 절 Create Fields
본장 교학 목적: Learning how to generate and animate Maya Fields.
본장의 주요 내용: Creating Fields such as wind, gravity, turbulence, etc.
본장 난점: Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

본장 중점: How to control total number of particles and control movement of particles with turbulence, gravity, vortex, velocity


본장 사고문제: Controlling Velocity of Particles, Emit with Fields to make natural movement

제 11 장 Maya Effects 1

1 절 Introduction about Maya Effects
2 절 Create Maya Effects

본장 교학 목적: Learning how to generate and animate Maya Effects.

본장의 주요 내용: Creating Maya Effects.

본장 난점: Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

본장 중점: How to control total number of particles and control movement of Maya Effects


본장 사고문제: Controlling Maya Effects to make natural movement

제 12 장 Maya Effects 2

1 절 Create curve flow
2 절 Create a surface flow

본장 교학 목적: Learning how to generate and animate Maya Effects.

본장의 주요 내용: Creating Maya Effects.

본장 난점: Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.

본장 중점: How to control total number of particles and control movement of Maya Effects

본장 참고문헌: 주교재: Main teaching material: Maya Visual Effects The Innovator's

본장 사고문제: Controlling Maya Effects to make natural movement

제 13 장 Maya Effects 3

1 절 Create lightning Maya Effects
2 절 Create shatter Maya Effects
3 절 Create Smoke Maya Effects

본장 교학 목적: Learning how to generate and animate Maya Effects.
본장의 주요 내용: Creating Maya Effects.
본장 난점: Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.
본장 중점: How to control total number of particles and control movement of Maya Effects

본장 사고문제: Controlling Maya Effects to make natural movement

제 14 장 Maya Effects Assets

1 절 Introduction about Effects Assets
2 절 Create Effects Assets

본장 교학 목적: Learning how to generate and animate Maya Effects Assets.
본장의 주요 내용: Creating Maya Effects Assets.
본장 난점: Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.
본장 중점: How to control total number of particles and control movement of Maya Effects Assets

본장 사고문제: Controlling Maya Effects Assets to make natural movement

제 15 장 Making waves with BOSS
1 절 Get started making waves with BOSS
2 절 Overview of the BOSS Editor
3 절 Add and edit BOSS solvers
본장 교학 목적 : Learning how to generate and edit BOSS.
본장의 주요 내용 : Creating Waves with BOSS.
본장 난점 : Students who do not have basic knowledge of physics will have difficulties due to unfamiliar terms of physics.
본장 중점 : How to control Waves with BOSS
본장 사고문제 : Controlling BOSS to make natural waves

제 16 장 Final Project
1 절 Final Project
본장 교학 목적: Understanding CG VFX Production Process through Final Project
본장의 주요 내용 : Planning to make a VFX shot
본장난점 : none.
본장중점 : Students will practice all the knowledge and skills they learned in this class to make their VFX shots.
본장 사고문제 : what is better and efficient CG Process .

五、 실험 및 실습내용 实验及实习内容

六、 평가방식 및 요구 评价方式及要求

Project80% and attitude20%
추천 교재 및 참고서적

중남재경정법대학
학사과정 수업 진도 계획표
学士课程教学进度计划表

(2018 학년도 제 1 학기)
(2018 年第一学期)

학원학: 한중뉴미디어학원 韩中新媒体学院
강연교사 讲课教授: 최동혁
학과명칭 课程名称: Particle Effects
학과번호 课程代号:
과정유형 课程类型:
총 교 시 总 课 时: 45 hours
기 본 정 보

<table>
<thead>
<tr>
<th>강연교사</th>
<th>Choi, Donghyuk</th>
<th>직 위</th>
<th>Assistant Professor</th>
</tr>
</thead>
<tbody>
<tr>
<td>학 위</td>
<td>Master Degree</td>
<td>학위</td>
<td>Master Degree</td>
</tr>
<tr>
<td>과목명칭</td>
<td>Particle Effects</td>
<td>과목번호</td>
<td>교시(학점)</td>
</tr>
<tr>
<td>수업대상</td>
<td>(전공,학년) (전공,학년)</td>
<td>수업대상</td>
<td>교시(학점)</td>
</tr>
<tr>
<td>수업대상</td>
<td>(전공,학년) (전공,학년)</td>
<td>수업대상</td>
<td>교시(학점)</td>
</tr>
<tr>
<td>수업대상</td>
<td>(전공,학년) (전공,학년)</td>
<td>수업대상</td>
<td>교시(학점)</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>연구실 검토 의견</td>
<td>연구실 주임 연구실 주임 (싸인) 년 월 일</td>
<td></td>
<td></td>
</tr>
<tr>
<td>학과주임 검토 의견</td>
<td>학과 주임 (싸인) 년 월 일</td>
<td></td>
<td></td>
</tr>
<tr>
<td>학원(부서) 검토 의견</td>
<td>학원 담당자 (싸인) 학원도장</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>학사일정 주간</th>
<th>수업내용 배정 (요점 기재)</th>
<th>수업형식 및 수단</th>
<th>수업 외 숙제 또는 지도 안배</th>
<th>집행 상황</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction to Particle Effect</td>
<td>Operate the multimedia</td>
<td>Orientation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Activity</td>
<td>Class</td>
<td>Multimedia</td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>----------</td>
<td>-------</td>
<td>------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 2 | 2 | Bullet Rigid Dynamics  
- Create Bullet Soft Body Anchors  
- Create a Bullet Ragdoll  
- Create Collisions with Bullet Rigid bodies | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 3 | 3 | Soft Body Dynamics  
- Create a cloth simulation with Bullet Soft Body  
- Create a hinge simulation with Bullet Rigid Bodies  
- Shatter a Rigid Body simulation | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 4 | 4 | nParticles 1  
- Emit nParticles  
- Create individual nParticles, nParticle clouds, and nParticle grids  
- Create nParticle liquids | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 5 | 5 | nParticles 2  
- Edit nParticle emitter attributes using workspace manipulators  
- Color emitted particles using a texture  
- Create a Rigid Set from Multiple Objects | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 6 | 6 | Fluid Effects 1  
- Import Fluid examples  
- Create dynamic fluid effects  
- Create non-dynamic fluid effects | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
<table>
<thead>
<tr>
<th>Week</th>
<th>Topic</th>
<th>Details</th>
<th>Activity</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 7    | Fluid Effects 2 | - Create a fluid containers with emitters  
- Color fluids using shading color  
- Emit fluids from objects | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 8    | Midterm | | | |
| 9    | Maya Fields 1 | - Introduction about Maya Fields  
- Create Fields | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 10   | Maya fields 2 | - Connecting and disconnecting Maya fields  
- Connect and disconnect collision geometry  
- Connect and disconnect emitters | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 11   | Maya Effects 1 | - Create a Fire effect  
- Create fireworks  
- Flow effects | Operate the multimedia class MAYA practicing | Check that students are following the experiments. Submit the project |
| 12   | Maya Effects 2 | - Create curve flow  
- Create a surface flow | Operate the multimedia | Check that students are following the experiments. |
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Procedures</th>
</tr>
</thead>
</table>
| 13      | Maya Effects 3 | - Create lightning  
- Create shatter  
- Connect shards to fields  
- Create Smoke |
| 14      | Effects Assets | - Introduction about Effects Assets  
- Create Effects Assets |
| 15      | Making waves with BOSS | - Get started making waves with BOSS  
- Overview of the BOSS Editor  
- Add and edit BOSS solvers  
- Add and edit BOSS influences  
- Cache BOSS solvers and influences |
| 16      | Final exam | |